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Safety Instructions

Safety Instructions • English

WARNING:	 This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within the 
product’s enclosure that may present a risk of electric shock.

ATTENTION:	 This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT:	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du produit 
d’une tension électrique dangereuse susceptible de provoquer un choc 
électrique.

ATTENTION:	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site 
Extron, www.extron.com.

Sicherheitsanweisungen • Deutsch

WARNUNG:	 Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in der 
im Lieferumfang enthaltenen Dokumentation besonders wichtige Hinweise 
zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:	 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению 
электрическим током.

ВНИМАНИЕ: 	 Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций 
по эксплуатации и обслуживанию в руководстве, 
прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других 
вопросах см. руководство по безопасности и соблюдению 
нормативных требований Extron на сайте Extron: www.extron.com, 
номер по каталогу - 68-290-01.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 电压，
有触电危险。

注意： 产品上的这个标志意在提示用户设备随附的用户手册中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 
使用的特性等相关内容，敬请访问 Extron 网站 www.extron.com，参见 
Extron 安全规范指南，产品编号 68-290-01。

Chinese Traditional（  )

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 
可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有重
要的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資
訊，請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規
遵守手冊》，準則編號 68-290-01。

Japanese

警告:	 この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
いない高電圧が流れ、感電の危険があることを示しています。

注意:	 この記号  が製品上に表示されている場合は、本機の取扱説明書
に 記載されている重要な操作と保守(整備)の指示についてユーザーの 注
意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイト www.extron.com より 『Extron Safety 
and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고: 	 이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:	 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 
대한 자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 
규제 준수 안내서, 68-290-01 조항을 참조하십시오. 

www.extron.com
www.extron.com
www.extron.com
www.extron.com
www.extron.com
www.extron.com
www.extron.com
www.extron.com


FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference. This interference must be corrected at 
the expense of the user.

NOTE:	 For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, 
accessibility, and related topics, see the “Extron Safety and Regulatory Compliance Guide” 
on the Extron website.

Copyright
© 2013  Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks®, registered service marks(SM), and trademarks(TM) are the property of 
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks (®)

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom, IP Link, 
Key Minder, LockIt, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, System 
Integrator, TeamWork, TouchLink, V‑Lock, VersaTools, VN‑Matrix,  VoiceLift, WallVault, WindoWall, XTP, and XTP Systems

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu‑Rate Frame Lock), ADSP (Advanced Digital Sync Processing), AIS (Advanced Instruction Set), Auto‑Image, CDRS (Class D 
Ripple Suppression), DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP 
(Digital Sync Validation Processing), FastBite, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, ProDSP, QS-FPC (QuickSwitch Front Panel 
Controller), Scope‑Trigger, SIS, Simple Instruction Set, Skew‑Free, SpeedNav, Triple‑Action Switching, XTRA, ZipCaddy, ZipClip
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Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

ATTENTION:	 Attention indicates a situation that may damage or destroy the product or 
associated equipment. 

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” is the capital 
letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.
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Introduction

This section describes this user guide and the EDID 101H, including:

•	 About this Guide

•	 About the EDID 101H

•	 EDID 101H Features

•	 Application Diagram

About this Guide
This guide contains information about the Extron EDID 101H with instructions on how to 
install, configure, and operate the unit. Throughout this guide the EDID 101H is referred to 
as the “EDID 101” or the “device”. 

About the EDID 101H
The Extron EDID 101H is an HDCP compliant EDID Emulator for HDMI signal sources. 
It features EDID Minder, an Extron exclusive technology designed to provide automatic 
and continuous Extended Display Identification Data (EDID) management. EDID Minder 
ensures that the source powers up properly and reliably outputs content. Pre-stored EDID 
is communicated to the source based on a user-selected resolution and refresh rate. The 
EDID 101H can also capture and store EDID information from a connected display. A unique 
Hot Plug Detect (HPD) port provides control for remote cameras and other signal sources 
that require a periodic HPD trigger. 

The EDID 101H is housed in a compact one-inch high, quarter rack width enclosure 
for convenient, discreet installation (see Mounting the EDID 101H on page 15). An 
energy‑efficient external universal power supply is included.

EDID 101H Features
EDID Minder — Automatically manages EDID communication between connected 
devices. EDID Minder ensures that all sources power up properly and reliably output content 
for display.

Selectable resolutions and refresh rates — Pre-stored EDID is communicated to the 
source based on a user-selected resolution and refresh rate. 

EDID capture mode — When connected to a display, the EDID 101H offers the option of 
capturing and then storing EDID information from the display device.

Supports computer video to 1920x1200, including HDTV 1080p60 and 2K.

HDCP compliant — Fully supports HDCP-encrypted sources.

HDCP authentication and signal presence LED indicators — Provide signal status for 
real-time feedback and monitoring of key performance parameters.

HDMI to DVI Interface Format Correction — Automatically reformats HDMI source 
signals for output to a connected DVI display.
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HPD - Hot Plug Detect control port — Provides unique contact closure control port for 
remote cameras and other devices that require a periodic HPD trigger for proper operation.

Automatic input cable equalization to 50 feet at 1080p60 with 8-bit color when 
used with Extron HDMI Pro Series cable — Actively conditions incoming HDMI signals 
to compensate for signal loss when using long cables, low quality cables, or source devices 
with poor signal output.

Provides +5 VDC, 250 mA power on the output for external peripheral devices

Includes LockIt HDMI cable lacing brackets

Energy-efficient external universal power supply included — Provides worldwide 
compatibility, low power consumption, and reduced operating costs.

Application Diagram

Figure 1.	 EDID 101H Application Diagram
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Installation and 
Configuration

This section describes the installation, and configuration of the EDID 101H, including:

•	 Installation Overview

•	 Front Panel Features

•	 Rear Panel Features and Cabling

•	 EDID Minder

•	 EDID 101H Configuration

Installation Overview

POWER
12V
0.3A MAX

EDID
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A B
A B

C

OUTPUTINPUT

EDID HPD

0
1

2

3 4 5 6 7
8

9
A

B
CDE

F

ON

1 2 3

1 2 3 4 5 6 97 8

Figure 2.	 EDID 101H Rear Panel

1.	 Mount the EDID 101H (see Mounting the EDID 101H on page 15). Do not connect 
power to the source, the display, or the EDID 101H at this time.

TIP:	 If access to the EDID 101H is restricted after mounting or installation, 
configure the EDID 101H prior to the installation.  

3.	 Configure the EDID 101H (see EDID 101H Configuration on page 11).

4.	 Connect an HDMI cable from the source to the Input (b).  

5.	 Connect an HDMI cable from the Output (c) to the video display or distribution system 
input.  

6.	 Connect power and turn on the video display or distribution system.

7.	 Apply power to the EDID 101H (a). The power LED lights green. 

8.	 Turn on the video source.

The video source reads the EDID from the EDID 101H.
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Front Panel Features

CONFIG

EDID 101HExtron

SIGNAL

HDCP

IN OUT

1 2 3 4

Figure 3.	 EDID 101H Front Panel Indicators and Configuration Port

a	 Power LED – Lights green when an external power supply is connected and powered.   

b	 Config port – Connect a host computer using a USB mini type‑B connector for 
configuration using SIS commands, and for firmware updates (see Connecting to the 
USB Port on page 16).  

c	 Signal In LED – Lights green when an HDMI signal is detected on the input.

HDCP In LED – Lights green when the source device requires HDCP encryption and 
the signal has been authenticated. 

d	 Signal Out LED – Lights green when an active sink (display) device is connected to the 
output.

HDCP Out LED – Lights green when HDCP is authenticated between the HDMI output 
and the connected sink device. This occurs only when the source device requires 
HDCP and is authenticated. 

If the source does not require HDCP or if the sink device is not HDCP compliant, the 
LED does not light.
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Rear Panel Features and Cabling
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Figure 4.	 EDID 101H Rear Panel

a	 Power Connector – Connect the included 12 VDC power supply to this two‑pole, 
3.5 mm captive screw connector. 

Rear Panel
Power Receptacle

DC Power Cord 
Captive Screw Connector

AC Power Cord

Ground  
+12 VDC 

External 
Power Supply
(12 VDC, 1 A )

Figure 5.	 12 VDC Power Connection to EDID 101H

ATTENTION:

•	 Always use a power supply provided by or specified by Extron. Use of an 
unauthorized power supply voids all regulatory compliance certification and 
may cause damage to the supply and the end product.

•	 Unless otherwise stated, the AC/DC adapters are not suitable for use in air 
handling spaces or in wall cavities. The power supply is to be located within the 
same vicinity as the Extron AV processing equipment in an ordinary location, 
Pollution Degree 2, secured to the equipment rack within the dedicated closet, 
podium, or desk.

•	 The installation must always be in accordance with the applicable provisions of 
National Electrical Code ANSI/NFPA 70, article 75 and the Canadian Electrical 
Code part 1, section 16. The power supply shall not be permanently fixed to 
building structure or similar structure.
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b	 HDMI input – Connect an HDMI source to this female HDMI type-A connector.   

HDCP – When required, the HDMI input negotiates and authenticates HDCP with a 
source device. The authentication process is repeated when a stored EDID is changed. 

c	 HDMI output – Connect a display or other output device to this female HDMI type‑A 
connector. The HDMI output provides +5 VDC, (up to 250 mA with over-current 
protection) on pin 16. 

HDCP – If a connected output device requires HDCP encryption, the EDID 101H output 
negotiates and authenticates HDCP directly.  

Video Format Correction – When the current input signal is HDMI and the connected 
output is DVI, the signal is converted to DVI format. This is based on the capability of 
the connected output device as listed in its EDID. 

The EDID information is read from the connected output device and written to memory 
whenever the output device is connected to this port and powered on.

NOTE:	 The EDID information is also read and stored whenever power is recycled 
to the connected output device or when the output device is replaced.

To securely fasten an HDMI cable to the EDID 101H using the included LockIt HDMI 
cable lacing brackets:

1.	 Plug the HDMI cable into the panel connection (see figure 5).

3

3

1 2 4
5

Figure 6.	 Installing the LockIt Lacing Bracket

2.	 Loosen the HDMI connection mounting screw from the panel enough to allow the 
LockIt lacing bracket to be placed over it. The screw does not have to be removed.

3.	 Place the LockIt lacing bracket on the screw and against the HDMI connector, then 
tighten the screw to secure the bracket.

ATTENTION:	 Do not overtighten the HDMI connector mounting screw. The 
shield it fastens to is very thin and can easily be stripped.

4.	 Loosely place the included tie wrap around the HDMI connector and the LockIt 
lacing bracket as shown.  

5.	 Hold the connector securely against the lacing bracket, then tighten the tie wrap 
and remove the excess length.
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d	 EDID Store LED – One bi-color LED lights green when power is connected. It flashes 
amber when reading and storing EDID from a connected output device, returning to 
green when recording is complete.

e	 EDID Store button – One recessed push button initiates both reading and storing 
EDID. With both A and B DIP switches set off (down), press the store button to read 
the EDID of a device connected to the output. The EDID is then stored to a user slot 
selected by the rotary switch. Up to 15 EDID files can be stored. 

Reset – To reset the EDID 101H to its default state, press and hold the EDID button 
while applying power. As power is applied, all front panel LEDs blink three times 
indicating a successful reset.

f	 EDID selection rotary wwitch – One 16‑position rotary switch combined with 
DIP switches A and B (see figure 4, g on page 5) provide a choice of user stored or 
pre‑programmed EDID (see EDID 101H Configuration on page 11).

User Loaded EDID – With both DIP switches off (down) rotary positions 1 through F 
store user loaded EDIDs (see Record EDID to a Memory Slot: on page 11). The 
memory slot is selected before initiating the EDID read and store. 

Automatic EDID – With both DIP switches off (down) and the rotory switch at 
position 0, the EDID of a device connected to the output is automatically stored upon 
detection of HPD. If no device is detected, the default EDID (720p60) is loaded.  

g	 DIP switch A and B – Two 2-position DIP switches, A and B, are used with the rotary 
switch to select from pre‑programmed HDMI and DVI EDID, or to allow recording a 
custom EDID from a connected display. The “off” position is down.

h	 DIP Switch C – DIP switch C enables (default: up) or disables (down) HDCP 
authorization.

i	 Hot Plug Detect (HPD) – One 2-pole 3.5 mm captive screw 
connector used to manually toggle HPD on the HDMI input. 
When the two pins (A and B) are shorted together, an HPD event 
is initiated on the HDMI input.  

POWER
12V
- - A MAX

EDID
STORE

A B
A B

C

OUTPUTINPUT

EDID HPD
0

1
2

3 4 5 6 7
8

9
A

B
CDE

F

ON

1 2 3

Momentary
Push
Button

NOTES:

•	 The length of the exposed wires in the stripping process is critical. The ideal 
length is 3/16 inch (5 mm). If it is any longer, the exposed wires may touch, 
causing a short circuit between them. If it is any shorter, the wires can be easily 
pulled out even if tightly fastened by the captive screws.

•	 Do not tin the wires. Tinned wire does not hold its shape and can become 
loose over time.
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EDID Minder
EDID Minder ensures that the connected source sees the EDID of a display, even if a display 
is not connected. Depending on the EDID mode selected, the EDID of a connected display 
can be stored automatically, or the user can manually select from the table of factory loaded 
EDID files. This EDID is stored in the EDID 101H.

Automatic Mode
In automatic mode (see Record EDID Automatically: on page 11), the EDID 101H 
automatically reads and stores EDID from the connected output. This EDID is retained until 
a different display is connected or the unit is power cycled. If no display is connected when 
the unit is powered on, a factory default EDID (720p @ 60 Hz, 2-Ch audio) is present.

User Assigned Mode
In user assigned mode (see Assign Pre-programmed EDID: on page 11), the user can 
select from 48 factory loaded EDID files, each catagorized by rate type (PC or HDTV), video 
format (DVI or HDMI), audio type (2-Ch or Multi-Ch), and native resolution. The unit retains 
this setting after a power cycle.

Additionally, fifteen user-loaded slots are available to save the EDID of connected displays 
(see Record EDID to a Memory Slot: on page 11). EDIDs saved to these slots are 
retained after a power cycle. Upon a factory reset, these EDIDs revert to the factory default 
(720p @ 60 Hz, 2-Ch audio).

A table showing the factory loaded EDID options is shown on the following page. The EDID 
memory location is labelled X@ for consistency with the memory location SIS command.
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Footnotes for the EDID table (see page 9)

The following footnotes apply to the EDID table on the previous page:
1Rate Type

•	 PC – These EDIDs are primarily VESA standard computer rates, based on the most 
commonly used native resolutions. They are designed for use with computer sources.

•	 HDTV – These EDIDs are video rates standardized by SMPTE and CEA. They are 
designed to be used with video and computer sources.

2 Video Format

•	 DVI – These EDIDs are 128-byte EDID files, which specify a DVI sink. They do not 
contain an extension block.

•	 HDMI – These EDIDs are 256-byte EDID files, each containing a CEA extension 
block. They each specify an HDMI sink device with audio support.

3Audio Type

•	 n/a – These EDIDs are DVI formatted EDID files that do not support audio.

•	 2-Ch – These EDIDs are HDMI formatted EDID files, with support for basic LPCM 
(2‑Ch) audio.

•	 Multi-Ch – These EDIDs are HDMI formatted EDID files with support for multiple 
audio formats, up to 8 channels.

•	 LPCM (2-Ch)

•	 LPCM (8-Ch)

•	 Dolby Digital (6-Ch)

•	 DTS (7 Ch)

•	 Dolby Digital Plus (8-Ch)

•	 DTS-HD (8-Ch)

•	 Dolby TrueHD (8-Ch)
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Record EDID to a Memory Slot:
To record EDID from a connected display:

1.	 Set DIP switches A and B (g) to the down (off) position.

2.	 Turn the rotary switch (f) to the desired user slot location (1 through F) to store the 
display EDID.  

3.	 Connect the display device to the Output connector of the 
EDID 101H (see figure 3, c on page 5).

4.	 Connect a power source and apply power to the EDID 101H. 
The green power LED lights when power is available.

5.	 Power on the display device.

6.	 Press EDID STORE (e) once to store the display EDID to the 
memory slot selected in step 2. The LED (d) flashes amber. 
When the LED returns to green, the EDID is stored.

NOTE:	 An EDID stored in user slots 1 through F is saved until a new EDID is 
manually stored to that slot or the device is reset.

Assign Pre-programmed EDID:
Configure the DIP switches and rotary switch corresponding to the desired native rate, video 
format, and audio format (see EDID 101H Memory Slot Locations on page 9).

NOTE:	 Configuring the EDID 101 rotary and DIP switches allow a user to select a 
pre‑programmed EDID file based on the native rate of a display (such as 1280x1024 
@ 60 Hz), but does not force a video source to output that rate. Since EDID reporting 
is not limited to a single video rate (the native rate), each Extron EDID also lists other 
common video rates for use by the video source.

EDID 101H Configuration
The EDID 101H can be configured prior to installation. EDIDs are recorded from a display or 
a pre-programmed EDID is selected. 

TIP:	 If access to the EDID 101H is restricted after mounting or installation, configure 
the EDID 101H prior to the installation.  

POWER
12V
0.3A MAX

EDID
STORE

A B
A B

C

OUTPUTINPUT

EDID HPD

0
1

2

3 4 5 6 7
8

9
A

B
CDE

F

ON

1 2 3

1 2 3 4 5 6 97 8

Record EDID Automatically:
1.	 Set DIP switches A and B (g) to the down (off) position.

2.	 Turn the rotary switch (f) to position 0.  

3.	 Connect a power source and apply power to the EDID 101H. 
The green power LED lights.

4.	 Connect the display device to the Output connector of the 
EDID 101H (see figure 3, c on page 4).

5.	 Power on the display device.

6.	 The display EDID data is automatically read and stored to rotary switch position 0.

NOTE:	 The EDID stored in this memory slot updates automatically when a different 
display is connected to the output. It reverts to the default EDID after a power 
cycle. 

POWER
12V
- - A MAX

EDID
STORE

A B
A B

C

OUTPUTINPUT

EDID HPD

0
1

2

3 4 5 6 7
8

9
A

B
CDE

F

ON

1 2 3

1 2 3 4 5 6 8 97
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Remote 
Communication and 
Control

This section describes remote operation of the EDID 101H. Topics include:

•	 Using Simple Instruction Set (SIS) Commands

•	 Command and Response Table for SIS Commands

Using Simple Instruction Set (SIS) Commands
The EDID 101H is remotely set up and controlled using Extron SIS commands issued from 
a host computer or other device, such as a control system. SIS commands are issued from 
the computer USB port to the front panel Config port (see Connecting to the USB Port 
on page 16 to connect to this port).

Host-to-device Communications
SIS commands consist of one or more characters per field. No special characters are 
required to begin or end a command sequence. You can enter these commands from 
your computer using a communication software program such as Extron DataViewer 
or HyperTerminal. When the device determines that a command is valid, it executes the 
command and sends a response to the host device. 

Most responses from the EDID 101H to the host computer end with a carriage return and 
a line feed (CR/LF = ]), which signals the end of the response character string. A string is 
one or more characters.  

Device-initiated Messages
When a local event such as a front panel selection or a change in signal status takes place, 
the switcher responds by sending a message to the host, indicating what change has 
occurred. No response is required from the host.
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Error Responses
If the device is unable to execute a command it receives because the command is invalid or 
contains invalid parameters, the device returns an error response to the host. The following 
error response codes can be sent:

E01 – Invalid input channel number (out of range) 
E10 – Invalid command 
E13 – Invalid value (out of range)

Using the Command and Response Table
The command and response table is shown on the following pages. Symbols are used 
throughout the table to represent variables in the command and response fields. Symbol 
definitions and an ASCII-to-hexadecimal (HEX) conversion table are shown below. 
Command and response examples are shown throughout the command and response 
table.

NOTE:	 Upper and lower case text can be used interchangeably unless otherwise 
stated.

• 

Space

l

I

ASCII to HEX  Conversion Table

Figure 7.	 ASCII to Hex Conversion Table

Symbol Definitions

] = CR/LF (carriage return with line feed) (hex 0D 0A)

}   Soft carriage return (no line feed)

• = Space

E = Escape

X! = Status 
0 = Off, disabled, or undetected 
1 = On, enabled, or detected

X@ = The EDID memory slot location from EDID table  (see EDID 101H Memory 
Slot Locations on page 9). 
1 through 48 = factory assigned slots 
49 = automatically detected EDID slot 
50 through 64 = user assigned slots

X# = 256 bytes of raw hex data (text representation).

X$ = Native resolution and refresh rate.

X% = Unit name. The name can have up to 24 alphanumeric characters 
including hyphens (-), with no spaces. The first character must be a letter, 
and the last character cannot be a hyphen.  
The default is EDID-101H.

X^ = Software version to the second decimal place.
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Command ASCII Command 
(Host to Device)

Response 
(Unit to Device) Additional Description

Video Mute
Video mute X! B Vmt X! ] Mute the video signal.
View video mute status B X! ] Show video mute status X!.  

1 = muted, 0 = unmuted (default)

Audio Mute
Audio mute X! Z Amt X! ] Mute the audio signal.
View audio mute status Z X! ] Show audio mute status X!.  

1 = muted, 0 = unmuted (default)

Signal Status
Request status of all signals E LS } SigI X! • SigO X! • HdcpI X! • HdcpO X!]

Show signal presence or absence for all 
inputs and the output. 
I = input 
O = output 

DIP C (HDCP authorized) 
status

E STAT } Dip X! ]

EDID Minder
View native EDID resolution E N EDID } X$ ] Show native resolution and refresh rate 

X$ from current EDID selection.. 
Example: 1600x1200 @ 60 Hz ]

View EDID assignment E A EDID }  EdidA X@ ] 1-64 (see the EDID 101H Memory Slot 
Locations on page 10).

View EDID in hex format E R EDID } X# ] X# = current EDID assignment: 
256 bytes of raw hex data (text 
representation).

Import EDID to specified 
memory slot

E S X@ EDID } Edid S X@ ] Store the EDID of the connected display 
as user-assigned EDID file X@.  
X@ = 50 through 64

Export EDID from any slot E N EDID } X$ ] Show native resolution and refresh rate 
X$ from current EDID selection.

Device Name
Set device name E X% CN } Ipn • X% ] X% can consist of up to 24 alphanumeric 

characters, including the hyphen (-).
Set name to default E • CN } Ipn • EDID-101H]

View unit name E CN } X% ] Show the current device name (X%).

Information Requests
Request part number N 60-nnn-nn ] Show the part number of the device

Query firmware version Q X^] Show firmware build number X^, 
expressed to the second decimal place.

Resetting
Reset E ZXXX } Zpx ] Reset the device to its factory default 

values. 
Firmware
Upload firmware E UPLOAD } ...go UPL ] after upload completes. 

Command and Response Table for SIS Commands 
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Reference 
Information

•	 Mounting the EDID 101H

•	 Connecting to the USB Port

•	 DataViewer

•	 Updating the Firmware

Mounting the EDID 101H
The one inch high, quarter-rack width three inch deep enclosure can be
•	 Set on a table,
•	 Mounted on a rack shelf,
•	 Mounted under a desk or table-top.

Desktop Placement
Attach the four provided rubber feet to the bottom of the EDID 101H and place it in any 
convenient location.

Rack Mounting

UL Guidelines for Rack Mounting

The following Underwriters Laboratories (UL) guidelines are relevant to the safe installation of 
these products in a rack:

Elevated operating ambient temperature — If the units are installed in a closed or 
multiunit rack assembly, the operating ambient temperature of the rack environment may be 
greater than room ambient temperature. Therefore, install the equipment in an environment 
compatible with the maximum ambient temperature (Tma: +122 °F, +50 °C) specified by 
Extron.

Reduced air flow — Install the equipment in the rack so that the equipment gets adequate

air flow for safe operation.

Mechanical loading — Mount the equipment in the rack so that uneven mechanical 
loading does not create a hazardous condition.

Circuit overloading — Connect the equipment to the supply circuit and consider the effect 
that circuit overloading might have on overcurrent protection and supply wiring. Consider 
the equipment nameplate ratings when addressing this concern.

Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted equipment. 
Pay particular attention to supply connections other than direct connections to the branch 
circuit (such as the use of power strips).

Rack Mounting Procedure

To mount the unit on a rack shelf, follow the instructions provided with the shelf accessories.
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Connecting to the USB Port
A mini type- B USB Config port located on the front panel (see Front Panel Features on 
page 4) is used to connect to a host computer for configuration using SIS commands 
with Extron DataViewer, or for updating firmware with the Extron Firmware Loader utility. 
DataViewer and Firmware Loader are available at www.extron.com. The programs are also 
necessary to install the USB driver to the connected computer.

To connect the EDID 101H to a host computer:

NOTE:	 If an Extron USB device has never been connected to the host computer, 
prior to connecting the Config (USB) port for the first time, you must install and 
activate the USB driver. The simplest way to do this is to install either Dataviewer 
(see DataViewer on page 18) or the Firmware Loader utility (see Updating the 
Firmware on page 19).

1.	 Connect a USB A to mini B cable between the Config port on the front panel of the 
EDID 101H and a USB port of the PC.

USB Cable

Type A
USB

Mini Type B
USB USB 1

USB
Ports

ComputerEDID 101H Front Panel

CONFIG

EDID 101H

SIGNAL

HDCP

IN OUT

Figure 8.	 Connecting a PC to the Front Panel USB Port

2.	 If this is the first time an EDID 101H is connected to the PC, the Found New Hardware 
Wizard opens (see figure 9). 

NOTE:	 The wizard opens only on the first occasion you connect the EDID 101H 
to that USB port. The wizard reopens if you connect the EDID 101H to a different 
USB port or if you connect a different piece of equipment, requiring a different 
driver, to the same USB port.

2

3

Found New Hardware Wizard

Welcome to the Found New 
Hardware Wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission].

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

Yes, this time only

Yes, now and every time I connect a device

No, not this time

Click Next to continue

Next > Cancel

Figure 9.	 Found New Hardware Wizard Welcome Screen

Select No, not this time. 

http://www.extron.com
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4.	 Click Next.

5.	 The following dialog box opens:

4

5

Found New Hardware Wizard

Welcome to the Found New 
Hardware Wizard
This Wizard helps you install software for:

If your hardware came with an installation CD
or floppy disk, insert it now.

What do you want the wizard to do?

Install the software automatically [Recommended]

Install from a list or specific location [Advanced]

Click Next to continue

Next > Cancel

Extron USB Device

Figure 10.	 Installing the Software Automatically

Select Install the software automatically (Recommended).

NOTE:	 You do not need to insert an installation disc.

6.	 Click Next.

The PC locates the driver needed and installs it in the correct location on the hard drive.

7.	 When the Completed dialog opens, click Finish to close the wizard.

NOTE:	 The wizard opens only on the first occasion you connect the EDID 101H 
to that USB port. The wizard reopens if you connect the EDID 101H to a different 
USB port or if you connect a different piece of equipment, requiring a different 
driver, to the same USB port.

8.	 Configure the EDID 101H as required (see Remote Communication and Control on 
page 12).
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DataViewer
DataViewer is an enhanced terminal emulation program that facilitates analysis of RS-232, 
USB, and TCP/IP communication with Extron devices. The software allows users to send 
commands to a device and view the responses in ASCII or hexadecimal format. Command 
and response logs can be saved in text or HTML format.

DataViewer is available at www.extron.com. Enter DataViewer in the search engine to 
locate the program. 

Download the installation file and load the program on the PC connected to the EDID 101H.

NOTES:	

•	 Only the USB tab is available for the EDID 101H.

•	 If an Extron USB device has never been connected to the host computer, after 
installing DataViewer, you must then install and activate the USB driver (see 
Connecting to the USB Port on page 16).

To run DataViewer:

1.	 Click the DataViewer desktop icon.

2.	 The Communications Setup dialog opens. 
Select the USB tab.

3.	 From the Port Configuration drop-down list 
select Extron USB Device.

4.	 Select the startup options.

To automatically connect to the EDID 101H, click 
Auto-connect on startup. 

5.	 Click OK to start using the program.

You are now ready to configure DataViewer or to 
begin entering commands.

Use the DataViewer help file for more information on 
the program. 

Extron USB Device

http://www.extron.com
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Updating the Firmware
Firmware updates are released periodically on the Extron website. You can find the version 
currently loaded on your device using SIS commands (see Command and Response 
Table for SIS Commands on page 14). Compare this with the latest release for the 
EDID 101H on the Extron website and decide whether to update your firmware.

TIP:	 Read the Release Notes provided on the website with the latest firmware to 
determine whether you need the latest version.

This section describes how to update firmware for the EDID 101H including:

•	 Download and Install Firmware Loader

•	 Downloading EDID 101H Firmware

•	 Loading the EDID 101H Firmware

Download and Install Firmware Loader
Use the Extron Firmware Loader utility to update the firmware on Extron products. If you do 
not already have Firmware Loader installed on your computer, download it as follows:

1.	 Go to the Extron website at www.extron.com and click the Download tab.

2.	 On the Download Center page, click the Software link from the list on the left sidebar 
menu.

3.	 Software downloads are arranged in alphabetical order. Click the “F” link, then locate 
Firmware Loader and click the Download link on the same row.

Description Part Number Version Date Size
Firmware Loader
Extron Firmware Loader is a computer software 
application that allows you to update Extron products 
with field-upgradable firmware. The software supports 
firmware updates to Extron products connected via USB, 
serial (RS-232), or addressable on your local area 
network (LAN). 

79-508-01 5.1 Jul 20, 2012 13.5 MB Download

Figure 11.	 Firmware Loader Download Link

The information page opens. 

4.	 Enter the requested information, then click Download fw_loader_vnxnxn.exe 
(where vnxnxn is the Firmware Loader version number).

5.	 Follow the instructions on the remainder of the download screens to save the 
executable Firmware Loader installer file to your computer. Note the folder to which the 
file was saved.

6.	 In your file browser, locate the downloaded executable installer file and double-click it to 
launch the installer.

7.	 Follow the instructions on the Installation Wizard dialog boxes to install Firmware Loader 
on your computer. Unless you specify otherwise, the installer program places the 
Firmware Loader file, FWLoader.exe, at c:\Program Files\Extron\FWLoader.

http://www.extron.com
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Downloading EDID 101H Firmware
To obtain the latest version of firmware for your device:

1.	 Go to the Extron website at www.extron.com and click the Download tab.

2.	 On the Download Center page, click the Firmware link from the list on the left sidebar 
menu.

3.	 The firmware files are arranged in alphabetical order. Click the “E” at the top the page, 
then locate EDID 101H firmware file and click its Download link.

NOTE:	 Click Release Notes. These notes show the issues addressed by the latest 
update. If these issues do not affect you, you may decide not to upgrade the 
firmware.

4.	 Click the EDID 101H Download link. The information page opens.

5.	 Enter the requested user information, then click Download.

6.	 Follow the instructions on the remainder of the download screens to save the 
executable firmware file to your computer. Note the folder to which the file was saved.

7.	 In your file browser, locate the downloaded executable file, and double-click it.

8.	 Follow the instructions on the Installation Wizard screens to install the new firmware on 
your computer. A Release Notes file and a set of instructions for updating the firmware 
are also loaded.

Loading the EDID 101H Firmware
To load a new version of firmware to the device using Firmware Loader, connect your 
computer to the front panel USB Configuration port (see Connecting to the USB Port on 
page 16). 

1.	 If you have not already done so, download and install the Firmware Loader executable 
installer file to your computer (see Download and Install Firmware Loader on 
page 19).

2.	 If necessary, download the latest version of EDID 101H firmware and install it on your 
computer (see Downloading EDID 101H Firmware above).

3.	 Open the Firmware Loader from the Start menu: 

Start > All Programs > Extron Electronics > Firmware Loader > Firmware 
Loader

The Firmware Loader program opens with the Add Device dialog displayed in front of it.

USB

EDID 101H

Figure 12.	 Opening Firmware Loader

http://www.extron.com
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4.	 On the Add Device dialog, select EDID 101H from the Device Names drop-down list.

5.	 From the Connection Method drop-down list, select USB.

6.	 Click Connect. If the connection is successful, EDID 101H is displayed in green in the 
Connected Device panel, followed by a green check mark.

USB

EDID 101H

EDID 101H

Connect

Connected Device

Device Name: EDID 101H

Add

New Firmware File (Optional)

Path: Browse

4

5
6

�

7

Figure 13.	 Add Device Dialog

7.	 To upload the firmware file, in the New Firmware File (Optional) panel, click Browse.  
The file browser opens.

8.	 Navigate to the new firmware file, which has an S19 extension, and double-click it.

EDID 101H

edid_101h_v1.00.0011_071213.S19

edid_101h_v1.00.0011_071213.S19

Figure 14.	 Open Dialog for Firmware File Selection

ATTENTION:	 Valid firmware files must have the file extension S19. A file with any 
other extension is not a firmware upgrade for this product and could cause the 
EDID 101H to stop functioning.
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NOTES:	

•	 The original factory-installed firmware is permanently available on the 
EDID 101H. If the attempted firmware upload fails for any reason, the unit 
reverts to the factory version.

•	 When downloaded from the Extron website, by default the 
firmware is placed in a folder at C:\Program Files\Extron\
Firmware\EDID 101H (Windows XP) or C:\Program Files (x86)\Extron\
Firmware\EDID 101H (Windows 7).

The path to the new firmware file is in the Path field (see figure 15).

4

5
6

USB

EDID 101H

EDID 101H

Connect

Connected Device

Device Name: EDID 101H

Add

New Firmware File (Optional)

Path: Browseedid_101h_v1.00.001_072113.S19

Add Next Cancel

Add Device...

�

9

Figure 15.	 Path to the New Firmware File on the Add Device Dialog

9.	 If this is the only device you are uploading firmware to, click Add. The Add Device 
dialog closes and the EDID 101H firmware file is added to the Devices panel of the 
Firmware Loader main screen.

If you are uploading the firmware to multiple EDID 101H units that are connected 
to your computer, do the following:

a.	 Click Add Next. Your first device is added to the Devices panel of Firmware Loader. 
The Add Device dialog remains open.

b.	 For each additional device you want to add to Firmware Loader, repeat steps 5 
through 9, then click Add Next. 

c.	 For the last device, click Add (instead of Add Next) to add the device and to close 
the Add Device dialog.

When the last device is added, the Add Device dialog closes and the EDID 101H 
firmware file is added to the Devices panel of the Firmware Loader main screen (see 
figure 16 on the next page).
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EDID 101H 60-1205-01 1.00.00 edid_101h_v1.00.001... Extron USB Device Connected

11
10b

Figure 16.	 Firmware Loader Screen with an EDID 101H Added

10.	 If there are multiple devices listed, but you do not want to upload the firmware to all, 
remove one or more using the Devices panel.

To remove one or more devices:

a.	 In the Device (n) panel, highlight the names of devices to delete by clicking on 
them. A checkmark is placed in the first column of each selected device.

b.	 Select Edit>Remove Selected Device(s) from the toolbar. The Remove 
Device(s) dialog opens.

c.	 From the Remove Device(s) dialog box, select or deselect devices on the list as 
desired, then click Remove.

To remove all devices, select Edit>Remove All Devices from the toolbar menu.

The dialog box closes.

11.	Click Begin. The following indicators show the progress of the update:

•	 The Transfer Time panel shows the remaining and elapsed time for the update.

•	 The Total Progress panel displays a progress bar with Uploading... above it.

•	 In the Devices panel, the Progress column displays an incrementing percentage 
and another progress bar. The Status column displays Uploading.

12.	The upload is complete when the Remaining Time field in the Transfer panel shows 
00:00:00, the Progress column shows 100%, and Completed is displayed above the 
progress bar and in the Status field. Close the Firmware Loader window.
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(Inside India Only)
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© 2013 Extron Electronics   All rights reserved.   www.extron.com

Contact Information

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876	 Europe:	 31.33.453.4040  
Asia:	 65.6383.4400	 Japan:	 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.

www.extron.com
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